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Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2010-2011 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
3



Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
4



Contents
1 Install the Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Before You Begin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Operating System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
HP Application Compatibility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Third Party Software Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Service Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Installation Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Path Notation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Installation Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2 Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Configure Service Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Task 1: Load the Service Manager Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Task 2: Update the Database Dictionary (dbdict). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Task 3: Configure the WebServer URL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Task 4. Configure User Capability Words . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Related Capability Words . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Request For Another Person . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Mass Update  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Task 5. Configure Notifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Refine the Service Manager Catalog. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Task 1: Remove Empty Categories  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Task 2: Remove Unsupported Characters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Task 3: Add Images for Catalog Items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Task 4: Multi-Company Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Task 5: Contact Lookup Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Do You Want Other Locales? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Task 1. Configure the Language in Service Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Task 2. Configure the User Profile. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Task 3. Localize the Item Record . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Task 4. Configure the Currency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Changing a Currency Code or Symbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Configure Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Pre-Requisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Sign on Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Out-of-Box Security Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
 5



Task 1. Service Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Task 2. Service Request Catalog  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Update applicationContext.properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Do You Want to Customize the Interface?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

3 Performance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Task 1. Remap the current.pending.groups Array. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Task 2. Remap the parent.tree Field  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Task 3. Remap the access.list Field  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Task 4. Remap the operators Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Task 5. Remap the members Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

4 Language Packs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Language Builder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Prerequisites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Install and Configure Language Builder  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Export Service Request Catalog Content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Prepare Exported Content. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Create Language Packs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Install the Language Pack. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Deploy the .war File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
6



1 Install the Application
This installation of Service Request Catalog assumes that you have the following:

• An existing installation of Service Manager 9.21 server and client

• Service Manager administration experience

• Access to Service Manager documentation

Before You Begin

Make sure that you complete all installation tasks for upgrading your Service Manager server 
to version 9.21. Start with the HP Service Manager 9.21 Release Notes and follow the 
directions to apply listed patches and defect fixes.

When your Service Manager server is ready, read the following sections to install the Service 
Request Catalog components. Make sure that you meet the requirements before you begin the 
Service Request Catalog 1.20p1 installation.

• Requirements on page 7

• Service Manager on page 8

• Installation Contents on page 8

• Installation Steps on page 10

Requirements

Service Request Catalog runs in a Windows environment using another HP application to 
serve and store data and requires the support of third party tools. 

Operating System

Service Request Catalog 1.20p1 is certified to run on Windows Server 2008 SP1 or SP2.

HP Application Compatibility

Service Request Catalog 1.20p1 runs with Service Manager 9.21. Service Request Catalog 
communicates with Service Manager through a web service.

Service Manager 9.21should be installed on a supported server listed in the Service Manager 
9.21 Compatibility Matrix.
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Third Party Software Requirements

Service Request Catalog 1.20p1 requires these external applications:

• AdobeFlash Player 10.1, which you can download here:
Adobe Flash Player Support Center

• Apache Tomcat 6.0.x, which you can obtain here: Apache Tomcat 6.x

Note: You can use an existing instance of Tomcat 6.0.x, or install a new Tomcat server. 

• The latest update version of SunJavaJDK 6 update 23 or a later release, which you 
can obtain here: Sun Developer Network

• Microsoft Internet Explorer v7 or a later release

If you plan to generate language packs, Language Builder requires InstallJammer 1.2.13 or a 
later release. 

Make sure you review all information in the HP Service Manager 9.21p1 Release Notes before 
you begin the installation process.

Service Manager

You must have an installed instance of the Service Manager 9.21server, and Service Manager 
9.21 Windows client to complete configuration tasks and make administrative changes to the 
service catalog items. For more information about administrative functions, see the Service 
Manager documentation.

Installation Contents

The Service Request Catalog installation package is a complete folder structure that contains 
the following components.

 Folder Name Contains

serviceRequestCatalog 

docs Service Request Catalog 1.20p1 documentation

files src-1.20p1.war file
src-1.20p1_encryptor.zip

freeOpenSourceSoftware Distributed open source code (do not install)

languageBuilder Tool to build language packs for non-localized languages
8 Chapter : Install the Application
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Components

This Installation Guide describes how to deploy and configure these components:

• A web application archive (src-1.20p1.war) file that creates a user interface to display 
Service Manager catalog source data through a web browser session.

• A simple encryption tool, (src-1.20p1_encryptor.zip) in a zip archive. The encryption tool 
encrypts the password of the Service Manager administrator.

Service Manager distributes the API unload that plugs into the Service Manager 
environment. The API component is the connector between Service Manager and Service 
Request Catalog that provides a continuous transparent dialog using web service technology.

The same data can be viewed directly with the Service Manager client. The API unload 
enables the casual user to browse the available products and services, choose one or more 
items, and submit a request. Service Manager accepts the request and routes it through a 
pre-defined approval and fulfilment process. At any time the user interface can display the 
status and details of pending, approved, and denied requests directly in the Service Request 
Catalog user interface.

For more information about installing the unload, see the Service Manager 9.21 patch Release 
Notes.

Path Notation

Specified installation folder and path locations are generally relative to the location of the 
installed Tomcat instance and deployment location of the src-1.20p1.war file. When you see a 
path that includes a hard drive letter (C:\), the actual location always depends on the user’s 
discretion. You can substitute the actual drive that you choose. When you see a path that 
includes an ellipsis (...), it represents the discretionary part of the path and folder structure on 
your local drive. For example:

C:\...\apache-tomcat-6.n.n

The C:\...\ notation expects that you chose the default installation path for Apache tomcat. 
When you encounter this path notation in examples, you can substitute your local 
conventions.
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Installation Steps

Follow These Steps

Install Apache Tomcat

1 If necessary, navigate to this download site to obtain the installation files for 
Apache Tomcat 6.0.n: tomcat.apache.org

Download the zip version to deploy manually or the 32-bit/64-bit Windows Service Installer.

2 Do one of the following to install Tomcat as a Windows Service or as a manual deployment:

Windows Service: Run the apache-tomcat-6.0.n.exe installer. Specify a convenient location 
for Tomcat. For example:

C:\...\apache-tomcat-6.0.n

When prompted for the Java location, note the path to the \jre folder. You will need this 
information later.

Manual Process: Unzip the files to a preferred location on the designated server. For 
example, unzip the files to:

C:\...\apache-tomcat-6.0.n

Deploy the Service Request Catalog .war file

3 To stop the Tomcat server, do one of the following depending on your selection in step 2.

Windows Service: Navigate to the Control Panel > Administrative Tools > Services 
dialog to stop the Apache Tomcat 6 service.

Manual Process: Run C:\...\apache-tomcat-6.0.n\bin\shutdown.bat.

4 In the installation package, locate C:\...\serviceRequestCatalog\files\src-1.20p1.war. Unzip 
the contents of the src-1.20p1.war file into an empty folder that you create to be the home 
location for this application. For example, if you create a new folder named \src-1.20p1 where 
you plan to deploy the .war file, the result would look like this: 

C:\...\src-1.20p1\war_file_contents

Do not unzip the war file into C:\...\apache-tomcat-6.0.n\webapps.

Create an encrypted password for the Service Manager administrator

5 From the installation package, extract the contents of 
C:\...\serviceRequestCatalog\files\encryptor-1.20p1.zip into a separate folder of your choice. 
For example: 

C:\...\src-1.20p1\encrypt

6 Click the executable file to start the encryptor application. 

C:\...\src-1.20p1\encrypt\runme.bat
10 Chapter : Install the Application
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7 At the command line prompt, type your Service Manager administration password. Your 
administrator rights must include SOAP API and service catalog capability. 

Enter your password: password_value

Press Enter.

Is this correct? Y/N: Y

Press Enter.

8 The encryption tool returns an encrypted password value:

This is your encrypted password: encrypted_password

Copy this encrypted value and save it to use in a subsequent step.

Note: If you want to enable more than one administrator, repeat step 6 through step 8 for 
each additional administrator.

Configure the Service Request Catalog URL

9 Open this file with a text editor:

C:\...\apache-tomcat-6.0.n\conf\server.xml

10 Navigate to the <Host></Host> section and locate the Context parameter. If the section is 
commented out, uncomment it. If it is missing, add the following.

<Context
docBase=""
path=""
reloadable="false" />

11 Specify the complete path to the folder where you unzipped the src-1.20p1.war file 
(docBase=). Specify the simplified path to be used in the URL (path=). 

For example: 

docBase="C:\...\serviceRequestCatalog"
path="/src-1.20p1"

Note: The docBase value and the path value do not have to be the same.

Configure Service Request Catalog properties

12 Open this file with a text editor: 

C:\...\src-1.20p1\WEB-INF\classes\applicationContext.properties

13 Change the properties in this file to match your client/server environment:

serviceManager.protocol=http (choose http or https protocol)

serviceManager.hostnameOrIP=127.0.0.1 (specify the host server by name or IP address)

serviceManager.port=13080 (specify a unique, or the default Service Manager, port number)

Follow These Steps
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14 In the # Caching section, locate this entry:

serviceManager.adminCredentials=LIST(userName,ENC(encryptedValue))

— Replace userName with the Service Manager administrator user name that you specified 
in step 7 on page 11. 

— Replace encryptedValue with the encrypted password text that you specified in step 8 on 
page 11.

Note: If you have more than one userName and encrypted password combination, use the 
following syntax and separate each unique entry with a comma:

=LIST(userName,ENC(encryptedValue),userName,ENC(encryptedValue))

15 (Optional) In the first # Performance section, change this parameter:

src.reloadCatalogAfterEvery=21600000

if you want the catalog cache refreshed more (or less) frequently than every six hours.

Express the value in milliseconds.

16 (Optional) In the second # Performance section, change this parameter:

src.refreshLookupsAfterEvery=21600000

if you want the catalog cache refreshed more (or less) frequently than every six hours.

Express the value in milliseconds.

17 (Optional) In the # Exchange Rates section, change this parameter:

src.refreshExchangeRatesAfterEvery=21600000

if you want exchange rates refreshed more (or less) frequently than every six hours.

Express the value in milliseconds.

18 (Optional) In the # SM config properties section, change these parameters:

src.sm.defaultMaxConnectionsPerHost=25
src.sm.maxTotalConnections=25

Specify a value between 25 to 60 depending upon the user traffic that you expect. Increase 
this value by 10 for each additional Service Manager node. Do not exceed 60 regardless of the 
number of Service Manager nodes. For example, if there are six or more Service Manager 
nodes supported by Loadbalancer, set this value to 60.

19 Save and close the file.

Start Apache Tomcat

20 To start the Tomcat server, do one of the following depending on your selection in step 2 on 
page 10.

Windows Service: Navigate to the Control Panel > Administrative Tools > Services 
dialog to start the Apache Tomcat 6 service.

Manual Process: Run C:\...\apache-tomcat-6.0.n\bin\startup.bat.

Follow These Steps
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Start the Service Request Catalog application

21 Type this URL into a supported browser window:

http://nn.nn.nn.nn:nnnn/src-1.20p1/

where nn.nn.nn.nn: is the IP address of the tomcat server, and :nnnn is the tomcat port 
number on that server.

22 Log in with your Service Manager credentials.

Follow These Steps
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2 Next Steps
After you install the Service Request Catalog 1.20p1 application, there are some additional 
configuration steps to follow. Basic tasks include installing and configuring the Service 
Manager application interfaces for Service Request Catalog, languages, and security.

• Configure Service Manager

• Do You Want Other Locales? on page 22

• Configure Security on page 26

• Refine the Service Manager Catalog on page 19

• Do You Want to Customize the Interface? on page 30

Configure Service Manager

There are a few Service Manager administrative tasks to complete before you begin using 
Service Request Catalog.

Task 1: Load the Service Manager Files

Follow the directions in the Service Manager Release Notes to apply any relevant .unl files. If 
necessary, follow these steps to complete that task.

1 To configure the Service Manager Windows client for a server side load/unload: 

a Start the Windows client

b From the main toolbar, click Window > Preferences > 

c On the HP Service Manager pane, clear the Client Side Load/Unload checkbox. 

d Restart the Windows client. 

2 In the left navigation pane, click Tailoring > Database Manager.

3 Right-click anywhere in the page and select Import/Load from the Option menu. 

4 In the File Name field, browse to locate the .unl file. 

5 Skip the optional Import Descriptor field.

6 Select winnt from the drop-down File Type list. 
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7 Choose one of the following options:

8 Repeat step 2 on page 15 through step 7 to load any remaining .unl files recommended for 
this release.

Task 2: Update the Database Dictionary (dbdict)

Complete the following steps to enable line item approval functionality.

1 Type db in the command line, and then press Enter.

2 Type Approval in the File Name field, and then press Enter.

3 Click the Keys tab, click the Unique key, and then click Edit Field/Key.

4 In the Fields list, click an empty item, type component, and then click OK.

5 Click Yes when you receive the warning message that you are modifying a key.

6 Click OK.

7 Repeat step 1 through step 6 to add the component unique key to the ApprovalLog file.

Task 3: Configure the WebServer URL

1 Start a Service Manager Windows client session.

2 Expand the navigation tree in the left pane.

3 Click System Administration > Base System Configuration > Miscellaneous > 
System Information Record, shown in Figure 7 on page 17.

4 On the System Information Definition form, click the Active Integrations tab.

5 Locate the Webserver Information section.

6 In the Webserver URL text box, shown in Figure 7, specify the URL to connect Service 
Manager to the Service Request Catalog application.step 13 on page 11

All Messages To see all messages that Service Manager generates loading the file. 

Totals Only To see only the total number of files Service Manager loads. 

None To hide all messages that Service Manager generates when loading 
the file. 

http://nn.nn.nn.nn Internet Protocol address of the Service Manager server 
(specified in step 13 on page 11).

:nnnn Configured port number on the Service Manager server 
(specified in step 13 on page 11).

/xxxxx/index.do Configured Service Manager application identifier.
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7 In the SRC URL text box, specify the URL to connect Service Manager to the Service 
Request Catalog application.

8 Save your changes.

Task 4. Configure User Capability Words

Service Manager best practices recommend assigning user roles that carry all the required 
capability words to be successful at their tasks. The required capability word for Service 
Request Catalog is service catalog. The service catalog capability word allows a user to request 
items from the service catalog. Other capability words may be required for role-based 
scenarios.

Related Capability Words

Depending on your task objectives, at least one of the following capability words must be part 
of each Service Request Catalog user profile.

Request For Another Person

You can order catalog items and services for another person only if the 
svcCatRequestOnBehalf capability word is part of your user profile. 

Mass Update

As an administrator, you can apply new capability words to a large group of users in a single 
operation. Follow the steps in Service Manager documentation that describes the mass update 
feature to apply a capability word to the user profile of a group of users.

Task 5. Configure Notifications

1 Start a Service Manager Windows client session.

2 Type db in the command line, and then press Enter.

3 Type Object in the Table Name field and press Enter.

4 Type incidents in the File Name field, and then press Search.

5 Click the Notifications tab.

http://nn.nn.nn.nn Internet Protocol address of the Service Request Catalog server.
This value could be localhost or an IP address.

:nnnn Assigned port number on the Service Request Catalog server .

/src-1.20p1 Configured Service Request Catalog application identifier 
(specified in step 11 on page 11).

Capability Word Description

svcCatDeptRequester An employee can request items from the catalog on behalf of 
a department.

svcCatEmployeeRequester An employee can request items from the catalog.

svcCatManagerRequester A manager can request items from catalog.
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6 In the Add field, type SM Add.

7 Right-click to display the Context menu. 

8 Click Save. A confirmation message should appear that says “Object record updated.”

9 From the left navigation pane, click Tailoring > Notifications > Notifications.

10 In the Name field on the Notification Definition record, type SM Add.

11 Click Search.

12 The Message tab enables you to define the message type, delivery method, and conditions 
under which Service Manager should send the notification. On the Message tab, insert the 
cursor in the first blank row and type the following values in the names fields.

13 Click Add.

14 Type fd in the command line, and then press Enter.

15 Type SD.notify.ess.open in the Form field and press Enter.

16 Select SD.notify.ess.open. Service Manager displays this form in the lower half of the 
workspace.

17 Right-click the form to display the Context menu.

18 Select Copy/Rename to display the “Copy/Rename a Format” form.

19 Replace SD.notify.ess.open with a new format name. Type SD.notify.src.open.

20 Make sure the Copy option is selected.

21 Click OK. Verify the new form saves successfully and that the name on the current Forms 
Designer tab is SD.notify.src.open.

22 On the toolbar above the form, click Design to open the Service Manager Form Designer 
tool.

23 Insert the cursor in the message field that says: “....please click this URL:”

24 There is a properties dialog for this section of the form that appears in the lower half of 
the workspace. This is the same area where Service Manager messages appear. In the 
Label for field, type $L.src.url.

25 Click OK to save your changes.

Column Name Type This Value

Msg Class sm

Msg No. 8

Arguments incident.id in $L.file

Condition not null($L.src.url)

Format SD.notify.src.open

Notify Method email

Recipients callback.contact in $L.file
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To verify that Service Manager is sending email messages, you can check the eventout table.

1 Type db in the command line, and then press Enter.

2 Type eventout in the Table Name field and press Enter.

Refine the Service Manager Catalog

Complete Task 1: Remove Empty Categories to maximize performance and Task 2: Remove 
Unsupported Characters to improve the user experience.

Task 1: Remove Empty Categories

Empty Service Manager categories (that contain no items) will cause a performance 
degradation when Service Request Catalog attempts to populate existing categories with child 
items. Service Catalog administrators should verify that the Service Manager Service Catalog 
contains no empty categories.

Task 2: Remove Unsupported Characters

Service Manager has a rich text editor that enables the Service Catalog administrator to 
embellish item descriptions with formatting, embedded links, and other readability 
enhancements. All of these formatting attributes do not render successfully when viewed 
through the Service Request Catalog interface. HP recommends that the Service Catalog 
administrator adjust these descriptions to limit formatting of the detailed description field to 
the following: 

• Links (<a>) to relative internal paths or absolute external URLs 

• Bold (<strong> or <b>) text 

• Line breaks (<br>) 

• These font (<font>) attributes:

— color (specified in hexadecimal values only)

— face (including a comma-delimited list of fonts)

— size (specified in pixels or relative points, such as +2 or -4)

— letterspacing

— kerning (0 or 1) 

• These image (<img>) attributes:

— src (required)

— width (in pixels)

— height (in pixels) 

• Italic (<i>) text 

• Leading spaces in category and item names

• These paragraph (<p>) attributes: 

— align (left, right, justify, center)
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— class 

• These span (<span>) attributes:

— class

— Note: Multiple properties in a single span tag, such as <span 
fontFamily=“Arial”>Hello</span>, are supported. Nested span tags are not supported. 

• These text formatting (<textformat>) attributes:

— indent

— blockindent

— leftmargin (in points)

— rightmargin margin (in points)

— leading (in pixels)

— tabstops (in a comma-delimited list) 

• Underlined (<u>) text 

• Simple lists. Simple lists render as unordered (bulleted) lists. Numbered lists are not 
supported. For example:

Note: Unsupported formatting will is ignored in the Service Request Catalog application. 

Task 3: Add Images for Catalog Items

You will obtain optimum results if all catalog images are the same size and in a similar 
format. Catalog items display as a “thumbnail” image. Follow these basic rules for attaching a 
thumbnail image to a catalog item:

• The maximum size is 196x140 pixels. Use a good image utility to crop or resize your 
images to a consistent size.

• The default background color for a smaller image is white. For consistency, consider 
adding an appropriate background to maintain the same image dimensions for all items.

• The recommended file type is .jpg or .png. Using other formats may produce unpredictable 
results.

Task 4: Multi-Company Mode

An administrator can configure Service Manager to support Multi-Company mode to filter the 
information that Service Request Catalog users see when making requests. In 
Multi-Company mode, Service Request Catalog users see only request items for their own 
company.

<ul>

</ul>

<li>Item</li>
<li>Item</li>
<li>Item</li>
<li>Item</li>

Note: Nested lists are not supported. 
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An administrator can also enable the Mandanten feature with Multi-Company mode to store 
company catalog data in its own secure database.

The recommended tasks in Service Manager are:

1 Enable Multi-Company mode in the System Information Company record. 

(System Administration > Base System Configuration > Miscellaneous > 
System Information Record > General)

2 Verify that you have a complete company record with Multi-Company enabled. 

(Tailoring > Database Manager > Table (company) > Search > company > Search > 
Show Company in Multi-Company Lists)

3 Enable Mandanten security by specifying a filtering condition for the svcCatalog and 
svcDisplay tables. Use the Mandanten Field Restriction form to specify MS.company in 
the Mandant Field Name field. Create two records: one for File Name svcCatalog and 
one for File Name svcDisplay.

(System Administration > Ongoing Maintenance> Mandanten > 
Mandanten Field Restrictions)

4 Create a Mandanten security group. The Security ID must be a an upper case value. For 
example: SRC. Type this value in the first row of the Include Value List. Click Add to 
save the security group record.

(System Administration > Ongoing Maintenance> Mandanten > 
Mandanten Security Groups)

5 If you enable Mandanten security, add the name of the Mandanten security group to the 
Security Groups tab on the operator record of each Service Request Catalog user. 

6 Assign the company to each category, sub-category, package, and item. This property does 
not cascade. If you are an advanced user, you can use these RAD scripts to accomplish this 
task: 

— d MS.company in $L.file

— x MS.company in $L.file="company name"

7 If you have more than one company defined in Service Manager, make sure each company 
has categories, subcategories, and producttypes assigned associated with service catalog.

For the detailed steps to complete each Service Manager task, see the Service Manager Help 
server.

Task 5: Contact Lookup Functionality

All Service Request Catalog users must have complete contact information specified in their 
Service Manager operator and contact records for the contact lookup to search successfully for 
a match.

The contact record and the operator record must contain the first name, last name, and 
company information for the user. Service Manager generates a formatted contact ID that 
may also be used in the contact lookup. For example, the Service Manager user Jennifer 
Falcon has this information in her company and operator records:

• Last name = Falcon

• First name = Jennifer

• Company = HP
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Her Service Manager generated contact ID is FALCON, JENNIFER.

If you are using the Contact lookup in Service Request Catalog, you can find her by typing one 
of the following:

• Her first name only

• Her last name only

• Both first and last name

• Her contact ID (in upper case)

Do You Want Other Locales?

Important: The complete Service Request Catalog release of version 1.20p1 occurs in two 
stages. The initial release is English only. There is a subsequent release that contains all 
language packs, localized Help system and user interface text for deployment in a 
multi-national environment. If your installation is not English, the subsequent release will 
enable you to complete any locale-dependent configuration. For more information, contact 
your HP Sales Representative.

When you deploy the complete language packs, Service Request Catalog provides complete 
out-of-box support for these languages:

• Brazilian Portuguese

• Dutch

• French

• German

• Italian

• Japanese

• Simplified Chinese

• Spanish

Complete support includes the application interface, error messages, and the Help system. 
There is also support in the application interface and error messages for these languages:

• Czech

• Hungarian

• Korean

• Polish

• Russian

Service Request Catalog also supports the currency code and symbol for each of these 
languages. However, you may have a global community of users who each want to view the 
contents in their preferred language. If this is the case, complete the steps in the following 
sections to enable as many locales as you wish. The only constraint is that each locale must be 
supported by Service Manager. Complete the first three tasks with a Service Manager client 
that connects to your Service Manager server.
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Task 1. Configure the Language in Service Manager

The first task is to make the selected language available when the user logs in to Service 
Request Catalog. Some languages may already be enabled on the Service Manager side. 
Others may not be enabled. Follow these steps to verify that your target language is enabled, 
or complete the steps to enable it.

1 From the Service Manager client, expand the left navigation and click Tailoring > 
Database Manager.

2 From the Table field, type or select:

language

3 Click the Search icon.

Service Manager returns a list of Service Manager language files.

4 Double-click the desired language file.

5 From the Language Identification dialog, click the Search icon.

A list of available languages appears. If the language you want has an active flag set to 
true, the language is enabled, and your task is complete. If the flag is false, proceed to the 
next step.

6 Select the language that you want to enable.

7 Check the empty Active for logins check box.

8 Click Save to update the language record.

9 Click OK.

10 Repeat step 1 through step 9 on page 23 to add more languages.

11 Click Back to exit this task.

12 Restart the Service Manager client to verify your changes.

Task 2. Configure the User Profile

The second task is to associate a default language with the individual user in their Service 
Manager user profile. For users in a multi-lingual environment, one might prefer to search 
the catalog in French, while another user would be more comfortable with Spanish. 

Note: If the user does not exist in the Service Manager system, you can follow these steps to 
navigate to the Operator Record dialog, but you must create the user before you complete the 
language association task.

1 Follow step 1 on page 23 through step 9 on page 23 to verify the target language is 
configured in Service Manager.

2 In the System Navigator pane, click System Administration > 
Ongoing Maintenance > Operators to edit the user’s operator record.

3 Click Search.

4 Select the user from the Login Name or Full Name column.

5 Click the Login Profile tab.

6 Click the Language drop-down list to select the default language for that user.

7 Click Save.
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8 Click OK.

9 Repeat step 2 through step 8 if you have more than one operator record to configure.

10 Click Back to exit this task.

Task 3. Localize the Item Record

To display any item in the user’s preferred language, you must add the specific language 
attribute to the item record. If you skip this step, the item appears in the default language.

1 In the System Navigator pane, click Service Catalog > Manage Catalog to locate the 
record to be localized.

2 Click Search. Service Manager displays a list of the item records in the catalog.

3 Scroll to find the target record in the list.

4 Click the record in the list to display all the record information in the Category Definition 
form.

5 When Service Manager displays the record, right-click anywhere in the form and select 
Localize this record from the context menu.

Service Manager displays the Create Localized Data wizard.

6 Choose the lang age from the drop-down list. For example, select German.

7 Replace the English Name, Short Description, and Long Description with equivalent 
values in the language you selected in step 6. 

8 Click Finish. Service Manager displays a confirmation message above the Category 
Definition form.

9 Repeat step 3 through step 8 to create localized versions of each catalog record.

10 When you are finished, click OK.

11 Click Back to exit the task.

Task 4. Configure the Currency

All currencies related to supported locales are available in the Service Request Catalog 
application. Currency values can appear with a symbol, such as the dollar symbol ($), or a 
code, such as USD (United States Dollars). The default display for the English locale is the 
currency symbol. The default display for non-English locales is the currency code. 

Changing a Currency Code or Symbol

You can change the way currency displays, or you can add a new code or symbol. For example, 
you would like to display using a different currency code or symbol, or even add a new 
currency. 
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Changing the Default Currency Symbol for Service Request Catalog

The Service Manager server normally provides localized item descriptions and converts the 
item cost to your locale currency symbol and value without intervention. You can override the 
currency display by overriding the default value. 

1 On the server where you deploy the Service Request Catalog, navigate to the Control 
Panel > Administrative Tools > Services dialog. Verify the Apache Tomcat service is 
stopped.

2 Navigate to this folder:

C:\...\src-1.20p1\resources\client\

All localization sub-folders contain translated text for the application.

3 Open the folder for your locale. For example, Hungarian translations are in this folder:

C:\...\src-1.20p1\resources\client\hu\

4 Open the CurrencySymbol_hu.properties file.

5 Locate the currency code and symbol that you want to display and remove the comment 
character from that entry.

6 Save and close the file.

7 Restart Tomcat.

Adding a New Currency to Service Manager

If you want to display items in the new locale using the correct currency value and symbol, 
browse the Service Manager documentation to locate “Displaying currency in the Service 
Catalog.” Follow the recommendations in this and related topics to make sure the: 

• Display currency field is set correctly in the affected operator records

• Currency table contains the correct currency definition record

• Currency conversion rate, established by the daily currency exchange rate, appears in the 
currency conversion table.

Adding a New Code and Symbol to Service Request Catalog 

In this example, we want to add the Korean code and symbol.

Follow these steps on the server where you deploy the Service Request Catalog .war file.

1 On the server where you deploy the Service Request Catalog, navigate to the Control 
Panel > Administrative Tools > Services dialog. Verify the Apache Tomcat service is 
stopped.

2 Navigate to this folder:

C:\...\src-1.20p1\resources\client\

All localization sub-folders contain translated text for the application.

3 The /ko folder contains all property files for the Korean locale. Open this file with a text 
editor:

C:\...\src-1.20p1\resources\client\ko\CurrencySymbol_ko.properties

4 Add the correct currency code and currency symbol to this file. For example, to add 
Korean currency, add this value:

KRW=\u20a9 
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5 Save and close the file.

6 Restart Tomcat.

Configure Security

Security represents the user authentication process that you plan to implement to enable 
access to the Service Request Catalog.

Pre-Requisites

The Service Request Catalog security administrator should be familiar with the following:

• How to configure Service Manager user roles and Trusted Signon for Service Manager 
users

• How to use the Java keytool utility and public key encryption

• The CA SiteMinder® authentication tool used by some HP enterprise applications

or

• The Spring Security framework (http://static.springsource.org/spring-security/site/)

Overview

SiteMinder is a single sign on tool for HP enterprise applications. After configuration, the 
enterprise application user logs into SiteMinder once to provide a full user name and 
password. Thereafter, SiteMinder shares the authentication information with other client HP 
applications to simplify the login process.

Spring Security is a security framework for enterprise software, especially those applications 
that include the Spring framework. Spring Security provides authentication and 
authorization for access control. It provides out-of-the-box implementations and also allows 
the use of customized ones. For more information about the current version of Spring Security 
(v2.0.5), see http://static.springsource.org/spring-security/site/reference.html

Sign on Methods

Service Request Catalog and Service Manager must work together to complete a user request 
but the authentication process for each application can vary.

• Service Manager uses only Trusted Sign on authentication for single sign on privileges. 

• Service Request Catalog uses Spring authentication for single sign on privileges.

• Both applications also accept a default sign on process where the user provides their 
Service Manager user name and password. 

In all cases, users must already have a user role and login permission to the Service Manager 
server connected to the Service Request Catalog application.
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Out-of-Box Security Features

Service Manager users have out-of-box Service Request Catalog user name and password 
login support with the following pre-configured modules:

• UsernamePasswordAuthenticationToken

• CatalogUserDetailsService

• CatalogAuthenticationProvider

• LogoutFilter

Task 1. Service Manager

The best resource for configuration information is the Service Manager documentation that is 
available through the Service Manager client or Help server. If the Service Request Catalog 
application is not deployed on the physical Service Manager server, follow these steps:

1 Stop the Service Manager server.

2 Generate a public/private key pair for the Service Request Catalog server using the 
keytool key and certificate management utility. For information, or for certificate-related 
questions, see 

http://java.sun.com/javase/6/docs/technotes/tools/solaris/keytool.html

3 Submit a Certificate Signing Request (CSR) to a trusted Certificate Authority (CA), such 
as Verisign®.

4 Retrieve the CA signed certificate for the Service Request Catalog server.

5 If Service Manager uses a default installation path, open this file with a text editor:
C:\Program Files\HP\Service Manager n.nn\Server\RUN\sm.ini file.

6 Locate the value for the ssl trustedClientsJKS property. The default name is 
trustedclients.jks.

7 Locate the .jks file in this default directory:
C:\Program Files\HP\Service Manager n.nn\Server\RUN\

8 If you generated your CSR using the trustedclients.jks file, import the CA signed 
certificate into the trustedclients.jks file using the keytool utility.

9  The keytool utility opens, saves, and closes the .jks file automatically

Note: If you have a separate keystore that contains your public/private key pairs, import 
the following into the trustedclients.jks file using the keytool utility:

— The separate keystore.

— The CA signed certificate

For more information, see the “Importing Keystore” section of

http://java.sun.com/javase/6/docs/technotes/tools/solaris/keytool.html

10 Restart the Service Manager server.
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Task 2. Service Request Catalog

Complete the steps in this section to configure Service Request Catalog.

Update applicationContext.properties

1 Stop Tomcat.

2 If Service Manager uses a default installation path, open this file with a text editor:

C:\Program Files\HP\Service Manager n.nn\Server\RUN\sm.ini file

You need to reference certain parameter values found in this file.

3 Open this file with a text editor:

C:\...\src-1.20p1\WEB-INF\classes\applicationContext.properties file 

4 Locate this section:

serviceManager.port=portnumber

Change the serviceManager.port=portnumber parameter to point to a secure server.

For example:

serviceManager.port=13443

where portnumber is the secure port number specified in the sm.ini file. 

.

.

.
httpsPort:13443
.
.
.

Note: HP recommends that you use a Fully Qualified Domain Name (FQDN), such as 
https://machine.hp.com:13443 (instead of an IP address), to match the FQDN specified 
when you configured the public/private key pair and the CA-signed-certificate for the 
Service Request Catalog application.

5 Locate this section:

src.trustStore=

6 Change the src.trustStore parameter to point to the location of the cacerts file. This 
file contains the public certificates for the Certificate Authorities that signed the Service 
Manager and Service Request Catalog server certificates. 
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For example:

src.trustStore=C:\Programs\HP\ServiceManager9.21\Client\plugins\
com.hp.ov.sm.client.common_9.21.000\cacerts

where cacerts is the same file as the one used by Service Manager. You can see the 
truststoreFile value specified in the sm.ini file:

.

.

.
truststoreFile:cacerts
.
.
.

7 Locate this section:

src.trustStorePassword=

8 Change the src.trustStorePassword= parameter to specify the password required to 
edit the trustStore file. For example:

src.trustStorePassword=changeit

where changeit is the truststorePass value specified in the sm.ini file: 

.

.

.
truststorePass:changeit
.
.
.

9 Locate this section:

src.keyStore=

10 Change the src.keyStore= value to point to the path and name of the keyStore file that 
you used to generate the public/private key-pair for the application. It is also the same file 
that you used to generate a CSR to be signed by a CA. For example:

src.keyStore=C:\Programs\HP\ServiceManager9.21\Client
\plugins\com.hp.ov.sm.client.common_9.21.000\application.keystore

11 Locate this section:

src.keyStorePassword=

Change the src.keyStorePassword= to specify the password required to edit the 
keyStore file. For example: 

src.keyStorePassword=password

12 Save and close the file.

13 Restart Tomcat.
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Do You Want to Customize the Interface?

Service Request Catalog enables you to change the branding information in the banner area 
of the user interface. The banner area is 400 pixels wide and 50 pixels high. Within this area, 
you can customize the interface with your logo and any other branding elements.

To prepare the banner image file:

1 Create a branding image that is 400 pixels wide and 50 pixels high.

2 Save the image with a .png file type.

3 Rename this image logo.png.

To post the new image file:

1 On the server hosting Service Request Catalog, stop the Tomcat service.

2 Store the new images in this folder:

C:\apache-tomcat-6.x\webapps\src-1.20p1\secure\branding\logo

3 Restart Tomcat.

4 Log into the Service Request Catalog application to view the new banner.
30 Chapter : Next Steps



3 Performance
The following changes to the Service Manager database are required to improve the 
performance of Web Services requests from Service Request Catalog. These steps should be 
completed by an experienced Service Manager administrator.

• Task 1. Remap the current.pending.groups Array

• Task 2. Remap the parent.tree Field

• Task 3. Remap the access.list Field

• Task 4. Remap the operators Field

• Task 5. Remap the members Field

These changes remedy the problem that occurs when the Service Manager server is unable to 
fully translate Service Manager queries to the SQL server when fields appearing in the query 
are mapped to large object (LOB) type fields. The recommended changes prevent inefficient 
scans by the Service Manager server when it runs queries against tables that reference LOB 
type fields. 

If you already mapped any repeating group in one of the referenced tables to an Array table, 
you will have an Array table that uses the A1 alias. In this case, use a different alias, such as 
A2, and append that alias value to the base table name to form the table name. For example, 
the detailed instructions in Task1 assume you do not already have an Array table for the 
Approval file. If you already have an A1 table, use alias A2 and name the table APPROVALA2 
instead. 

Task 1. Remap the current.pending.groups Array

Remap the current.pending.groups array from a CLOB/TEXT field to an Array table, 
creating APPROVALA1 table. Use the dbdict utility, not the system definition utility or the 
sql mapping utility.

To edit the dbdict for the Approval file

1 In the Fields pane, scroll down to and double-click the current.pending.groups array 
definition line.

2 Click the edit field.

3 Set SQLTable to a1.

4 Click Next. You should be positioned on the dbdict entry for the current.pending.groups 
character field.

5 Set SQLTable to a1.

6 Change the SQL type from CLOB to VARCHAR(60) and click OK.

7 Select the SQL Tables tab and add a new line with alias, name, and type of a1 
APPROVALA1 oracle10.
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8 Click OK. A pop-up dialog displays the DDL to create the new table.

Important: Do not modify the DDL.

9 Copy this DDL to the clipboard for future reference.

10 Click User Alters. Do not click SM Alters.

11 Click OK on the main dbdict window to update the dbdict. 

Note: After you click User Alters, Service Manager displays a dialog warning that you 
must now alter the database using the displayed DDL. However, Service Manager also 
tries to modify the database directly, using that DDL. If it succeeds, nothing further is 
required.

The operation will succeed, provided the sqllogin account information in the Service 
Manager sm.ini file is for a database user with the rights to issue CREATE TABLE and 
CREATE INDEX operations. If the sqllogin account information in the Service Manager 
sm.ini file is not for a database user who does not have these rights, the operation will 
fail, and an appropriately authorized user must manually run the DDL that you copied to 
the clipboard against the Service Manager database schema.

12 Verify that Service Manager succeeded in creating the new table and index by examining 
the Service Manager database in Oracle to see if the new APPROVALA1 table was 
created.

13 Note whether any SQL error messages appear. 

14 Use Oracle sql developer or another database management tool to verify that the 
APPROVALA1 table was created.

Task 2. Remap the parent.tree Field

The next task is to remap the parent.tree field in the capability file to an Array table. Use the 
dbdict utility, not the system definition utility or the sql mapping utility.

To edit the capability file to an Array table

1 Select the parent.tree type array.

2 Click the edit field.

3 Set SQLTable to a1.

4 Click Next. You should be on the parent.tree type character.

5 Change the SQL type to VARCHAR(50).

6 Change SQLTable to a1 and click OK.

7 Go to SQLTables.

8 Add a1 CAPABILITYA1 oracle10.

9 Click OK. A pop-up dialog displays the DDL to create the new table.

Important: Do not modify the DDL.

10 Copy this DDL to the clipboard for future reference.

11 Click User Alters. Do not click SM Alters.

12 Click OK on the main dbdict window to update the dbdict. 
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Note: After you click User Alters, Service Manager displays a dialog warning that you 
must now alter the database using the displayed DDL. However, Service Manager also 
tries to modify the database directly, using that DDL. If it succeeds, nothing further is 
required.

The operation will succeed, provided the sqllogin account information in the Service 
Manager sm.ini file is for a database user with the rights to issue CREATE TABLE and 
CREATE INDEX operations. If the sqllogin account information in the Service Manager 
sm.ini file is not for a database user who does not have these rights, the operation will 
fail, and an appropriately authorized user must manually run the DDL that you copied to 
the clipboard against the Service Manager database schema.

13 Verify that Service Manager succeeded in creating the new table and index by examining 
the Service Manager database in Oracle to see if the new CAPABILITYA1 table was 
created.

14 Note whether or not any SQL error messages are displayed. 

15 Use Oracle sql developer or another database management tool to verify that the 
CAPABILITYA1 table was created.

Task 3. Remap the access.list Field

The next step is to remap the access.list field in the svcCatalog file to an Array table. Use 
the dbdict utility, not the system definition utility or the sql mapping utility.

To edit the svcCatalog file to an Array table

1 Select the access.list type array.

2 Click the edit field.

3 Set SQLTable to a2.

4 Click Next. You should be on the access.list type character.

5 Change the SQL type to VARCHAR(50).

6 Change SQLTable to a2 and click OK.

7 Go to SQLTables.

8 Add a2 SVCCATALOGA2 oracle10.

9 Click OK. A pop-up dialog displays the DDL to create the new table.

Important: Do not modify the DDL.

10 Copy this DDL to the clipboard for future reference.

11 Click User Alters. Do not click SM Alters.

12 Click OK on the main dbdict window to update the dbdict.

Note: After you click User Alters, Service Manager displays a dialog warning that you 
must now alter the database using the displayed DDL. However, Service Manager also 
tries to modify the database directly, using that DDL. If it succeeds, nothing further is 
required.

The operation will succeed, provided the sqllogin account information in the Service 
Manager sm.ini file is for a database user with the rights to issue CREATE TABLE and 
CREATE INDEX operations. If the sqllogin account information in the Service Manager 
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sm.ini file is not for a database user who does not have these rights, the operation will 
fail, and an appropriately authorized user must manually run the DDL that you copied to 
the clipboard against the Service Manager database schema.

Task 4. Remap the operators Field

The next task is to remap the operators field in the kmgroup file to an Array table. Use the 
dbdict utility, not the system definition utility or the sql mapping utility.

To edit the kmgroup file to an Array table

1 Select the operators type array.

2 Click the edit field.

3 Set SQLTable to a1.

4 Click Next. You should be on the operators type character.

5 Change the SQL type to VARCHAR(60).

6 Change SQLTable to a1 and click OK.

7 Go to SQLTables.

8 Add a1 KMGROUPA1 oracle10.

9 Click OK. A pop-up dialog displays the DDL to create the new table.

Important: Do not modify the DDL.

10 Copy this DDL to the clipboard for future reference.

11 Click User Alters. Do not click SM Alters.

12 Click OK on the main dbdict window to update the dbdict.

Note: After you click User Alters, Service Manager displays a dialog warning that you 
must now alter the database using the displayed DDL. However, Service Manager also 
tries to modify the database directly, using that DDL. If it succeeds, nothing further is 
required.

The operation will succeed, provided the sqllogin account information in the Service 
Manager sm.ini file is for a database user with the rights to issue CREATE TABLE and 
CREATE INDEX operations. If the sqllogin account information in the Service Manager 
sm.ini file is not for a database user who does not have these rights, the operation will 
fail, and an appropriately authorized user must manually run the DDL that you copied to 
the clipboard against the Service Manager database schema.

13 Verify that Service Manager succeeded in creating the new table and index by examining 
the Service Manager database in Oracle to see if the new KMGROUPA1 table was 
created.

14 Note whether or not any SQL error messages are displayed. 

15 Use Oracle sql developer or another database management tool to verify that the 
KMGROUPA1 table was created.
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Task 5. Remap the members Field 

The next step is to remap the members field in the cm3groups file to an Array table.

To edit the cm3groups file to an Array table

1 Select the members type array.

2 Click the edit field.

3 Set SQLTable to a1.

4 Click Next. You should be on the members type character.

5 Change the SQL type to VARCHAR(60).

6 Change SQLTable to a1 and click OK.

7 Go to SQLTables.

8 Add a1 CM3GROUPSA1 oracle10.

9 Click OK. A pop-up dialog displays the DDL to create the new table.

Important: Do not modify the DDL.

10 Copy this DDL to the clipboard for future reference.

11 Click User Alters. Do not click SM Alters.

12 Click OK on the main dbdict window to update the dbdict.

Note: After you click User Alters, Service Manager displays a dialog warning that you 
must now alter the database using the displayed DDL. However, Service Manager also 
tries to modify the database directly, using that DDL. If it succeeds, nothing further is 
required.

The operation will succeed, provided the sqllogin account information in the Service 
Manager sm.ini file is for a database user with the rights to issue CREATE TABLE and 
CREATE INDEX operations. If the sqllogin account information in the Service Manager 
sm.ini file is not for a database user who does not have these rights, the operation will 
fail, and an appropriately authorized user must manually run the DDL that you copied to 
the clipboard against the Service Manager database schema.

13 Verify that Service Manager succeeded in creating the new table and index by examining 
the Service Manager database in Oracle to see if the new CM3GROUPSA1 table was 
created.

14 Note whether or not any SQL error messages are displayed. 

15 Use Oracle sql developer or another database management tool to verify that the 
CM3GROUPSA1 table was created.
35



36 Chapter : Performance



4 Language Packs
Service Request Catalog provides out-of-box support for the languages listed in Do You Want 
Other Locales? on page 22. If you want to translate a language that is not on this list, read the 
information in this chapter.

You will need to use the approved language code when you create and install language packs. 
The following table lists the languages that you can select.

Table 1 Supported Languages and Language Codes

Language Language Code

Arabic ar

Bokmal Norwegian nb

Bulgarian bg

Catalan ca

Croatian hr

Czech cs

Danish da

Dutch nl

English en

Estonian et

Finnish fi

French fr

German de

Greek el

Hebrew iw

Hindi hi

Hungarian hu

Icelandic is

Indonesian in

Italian it

Japanese ja

Korean ko
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Language Builder

HP Language Builder is a key element in an Open Localization Toolkit that enables users to 
add translation for languages that are not supported out-of-box. Language Builder is a 
standard framework that enables an automated localization process. This process is 
independent from the application functionality. Language Builder has two main features. 

• It identifies and extracts localizable content. 

• It generates a language pack installer for languages that are not supported out-of-box.

Latvian lv

Lithuanian lt

Macedonian mk

Malay ms

Norwegian no

Polish pl

Portuguese pt

Romanian ro

Russian ru

Simplified Chinese zh_CN

Slovak sk

Slovene sl

Spanish es

Swedish sv

Thai th

Turkish tr

Ukrainian uk

Vietnamese vi

Table 1 Supported Languages and Language Codes

Language Language Code
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Prerequisites

In addition to the requirements described on page 7, you must have InstallJammer v.1.2.14 
installed if you plan to build language packs. If you do not have this version, or a later release, 
installed, follow these steps.

1 In the installation package, locate 
C:\...\serviceRequestCatalog\languageBuilder\InstallJammer-1.2.14-Setup.exe.

2 Double-click InstallJammer-1.2.14-Setup.exe to begin the installation.

3 Select the target language. For example, select Russian. 

4 If you do not want InstallJammer to launch after installation, clear the appropriate 
checkbox.

The installer completes the installation process for InstallJammer.

Install and Configure Language Builder

1 In the installation package, locate C:\...\serviceRequestCatalog\languageBuilder\
LanguageBuilder-3.20.001-WinNT4.0.msi.

2 Double-click LanguageBuilder-3.20.001-WinNT4.0.msi to begin the installation.

3 Follow the onscreen directions to accept the license terms, select the installation location, 
and begin the installation.

4 When the process is complete, click Finish. The default installation path is 
C:\Program Files\HP\LanguageBuilder.

5 Navigate to the original source folder and extract the zip archive:

C:\...\serviceRequestCatalog\languageBuilder\SRC_Open_L10N.zip

to C:\

The result is a new folder: C:\SRCLP that contains these resources:

\HP_config\SRC_LP.mpi
cultures.xml
SRC_1.20.xml

Caution: The LanguageBuilder application requires this naming convention. Do not 
rename C:\SRCLP or SRC_1.20.xml.

6 Copy C:\SRCLP\cultures.xml.

7 Paste it in the LanguageBuilder installation folder:

C:\Program Files\HP\LanguageBuilder

This will replace the generic cultures.xml file with one customized for Service Request 
Catalog.
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Export Service Request Catalog Content

Follow these steps to prepare the localized content.

1 Copy the Service Request Catalog .war file (src-1.20p1.war) and paste it into the 
C:\SRCLP folder. Do not change the .war file name.

2 Open SRC_1.20.xml with a text editor.

3 Locate this property:

 <property name="PRODUCTWAR" value="server-core-1.20"/>

4 Change server-core-1.20 to match the name of the war file in step 1: src-1.20p1.

5 Save and close the file.

6 Start Language Builder by double-clicking the Language Builder (LB) shortcut on your 
Windows desktop, or navigate to the installation folder and click the following:

C:\Program Files\HP\LanguageBuilder\run.bat

7 Browse to the location of the Language Builder Configuration file. It is in the folder that 
you created in step 5 in the last section. For example: C:\SRCLP\SRC_1.20.xml

8 Browse to the location for the Working Space. For example: C:\SRCLP

HP recommends that you use the root folder where you stored the Language Builder 
resources. Otherwise, the results may be unpredictable.

9 Click Export. 

The status bar displays the export progress. The Monitor box lists the exported files. 

During the export process, the Language Builder creates and populates a sub-folder:

C:\SRCLP\EN contains sub-folders with Service Request Catalog property files. 

The process is finished when you see the message “Export Completed.”

Prepare Exported Content

Follow these steps to create each language that you need.

1 Copy this folder: C:\SRCLP\EN

2 Paste it into this directory: C:\SRCLP

3 Rename the EN copy to the new target language code. For example: C:\SRCLP\ru if the 
new target language is Russian.

4 Rename all \en sub-folders to match the new target language code. For example:

C:\SRCLP\language_code\exportwar\resources\client\ko

C:\SRCLP\language_code\exportwar\resources\server\ko

5 Complete the localization process to translate all property files from English to the new 
target language.

6 Rename all Service Request Catalog property files in the C:\SRCLP\...\client\en 
sub-folders to match the new target language code. 
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For example, all property files for the Russian language would be renamed to insert the 
language code preceded by an underscore (_).

C:\SRCLP
\ru

   \exportwar
      \resources
      \client

         \ru
            \AccountView_ru.properties

            \BundleDetails_ru.properties

7 Replace the prefix in all message strings in the C:\SRCLP\...\server\en sub-folders to 
with an underscore and the new target language code. 

8 Repeat step 1 through step 7 for each new language that you want to implement. Upon 
completion, you should have a folder structure that might look like this if you planned to 
generate multiple languages:

C:\SRCLP
\EN
\fi
\el
\iw
\ru

Create Language Packs

To create a language pack, follow these steps.

1 Start Language Builder by double-clicking the Language Builder (LB) shortcut on your 
Windows desktop, or navigate to the installation folder and click the following:

C:\Program Files\HP\LanguageBuilder\run.bat

2 Browse to the location of the Language Builder Configuration file. It is in the folder that 
you created in step 5 in the last section. For example: C:\SRCLP\SRC_1.20p1.xml

3 Browse to the location for the Working Space: C:\SRCLP

HP recommends that you use the root folder where you stored the Language Builder 
resources. Otherwise, the results may be unpredictable.

4 Click Create Language Installer. The Languages Selection dialog box displays the 
available target languages in the left-hand pane, which correspond to the language folders 
that you created in the working space.

5 Highlight the target language and click Add. For example, if you have a C:\SRCLP\ru 
folder, Russian appears in the left selection pane. If you click Add, Russian moves to the 
Selected Languages pane.

Click Start. The Language Builder creates a C:\SRCLP\SRC_LP folder: The new 
language pack appears in a sub-folder with the target language code. For example:

C:\SRCLP\SRC_LP\ru

6 Repeat step 1 through step 5 to add other language packs.
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Install the Language Pack

You can install a language pack into an existing src-1.20p1.war file.

1 Navigate to the language pack folder: C:\SRCLP

2 The language pack installer Language Pack-1.0-Setup.exe creates a localized version of 
the .war file. For example, if your target language is Russian, run:

C:\SRCLP\SRC_LP\ru\Language Pack-1.0-Setup.exe

3 Locate the parent folder of the .war file. If necessary create one for this purpose.

4 On the Service Manager server, navigate to this folder:

C:\Program Files\HP\Service Manager 9.21\Server\RUN

5 Create a new sub folder for your target language with the name of the code for that 
language. For example, if your target language is Russian, the folder name would be:

C:\Program Files\HP\Service Manager 9.21\Server\RUN\ru

6 Copy the translated SMAPIValidations_languageCode.properties file to the new folder on 
the Service Manager server. The result would look like this:

C:\Program Files\HP\Service Manager 9.21\Server\RUN\ru
\SMAPIValidations_ru.properties

7 Rename the translated SMAPIValidations_languageCode.properties file to message.str. 
This file should be in UTF-8 encoding. 

8 At the command line, run following command:

 %SM_Bin_Dir%/sm.exe -str_import:message -str_language:<languageName>

For example, for Russian, the command would be:

%SM_Bin_Dir%/sm.exe -str_import:message -str_language:Russian

9 After the import, you must re-install the Service Manager Server language pack.

Notes: 

• If your target language code includes a space, enclose it with double-quotation marks. For 
example:

sm.exe -str_import:message -str_language:"Simplified Chinese"

• If your target language is Indonesian, you must install a Service Manager Server patch to 
support that language. 

Deploy the .war File

When you complete all steps, you have created a localized .war file that you can deploy 
following the instructions in Chapter 1, Install the Application.
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